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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

Product
Name

HP Compaq 6535s Notebook PC    √

 HP Compaq 6531s Notebook PC   √  

 HP Compaq 6530s Notebook PC √ √   

Processors ● Intel® Core™2 Duo P7370 2.0
GHz processor, 3-MB L2
cache, 1066-MHz front side
bus (FSB)

 √ √  

 ● Intel Core2 Duo P8400 2.26
GHz processor, 3-MB L2
cache, 1066-MHz front side
bus (FSB)

 √ √  

 ● Intel Core2 Duo P8600 2.4 GHz
processor, 3-MB L2 cache,
1066-MHz front side bus (FSB)

 √ √  

 ● Intel Core2 Duo T9400 2.53-
GHz processor, 6-MB L2
cache, 1066-MHz FSB

 √ √  

 ● Intel Core2 Duo T5670 1.80-
GHz processor, 2-MB L2
cache, 800-MHz FSB

 √ √  

 ● Intel Core2 Duo T5870 2.00-
GHz processor, 2-MB L2
cache, 800-MHz FSB

 √ √  

 ● Intel Celeron® M 575 2.00-GHz
processor, 1-MB L2 cache,
667-MHz FSB

√    

 ● Intel Celeron M 585 2.16-GHz
processor, 1-MB L2 cache,
667-MHz FSB

√    

 ● Intel Celeron, Dual-Core T1600
1.66-GHz processor, 1-MB L2
cache, 667-MHz front side bus
(FSB)

√    
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Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

 ● Intel Celeron, Dual-Core T1700
1.83-GHz processor, 1-MB L2
cache, 667-MHz front side bus
(FSB)

√    

 ● AMD Turion™ X2 Ultra Dual-
Core ZM-86 2.4-GHz
processor, 35W, 2-MB L2
cache

   √

 ● AMD Turion X2 Ultra Dual-
Core ZM-84 2.3-GHz
processor, 35W, 2-MB L2
cache

   √

 ● AMD Turion X2 Ultra Dual-
Core ZM-82 2.2-GHz
processor, 35W, 2-MB L2
cache

   √

 ● AMD Turion X2 Ultra Dual-
Core ZM-80 2.1-GHz
processor, 35W, 2-MB L2
cache

   √

 ● AMD Turion X2 Dual-Core
RM-70 2.0-GHz processor,
35W, 1-MB L2 cache

   √

 ● AMD Turion X2 Dual-Core
RM-72 2.1-GHz processor,
35W, 1-MB L2 cache

   √

 ● AMD Athlon™ X2 QL-60 1.90-
GHz processor, 35W, 1- MB L2
cache

   √

 ● AMD Athlon X2 QL-62 2.0-GHz
processor, 35W, 1- MB L2
cache

   √

 ● AMD Sempron™ SI-40 2.00-
GHz processor, 25W, 512-KB
L2 cache

   √

Chipset Southbridge: Intel ICH9M √ √ √  

 Southbridge: AMD SB700    √

Graphics Mobile Intel Graphics Media
Accelerator 4500MHD

√ √   

 Intel Universal Memory Architecture
(UMA) graphics subsystem
integrated with shared video
memory (dynamically allocated)

√ √   

 ATI Radeon HD 3430   √  
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Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

 ATI-M82se discrete graphics
subsystem memory with
hypermemory support

● 128MB GDDR2 - 500 MHz
(16Mx16, Qty 4)

● 256MB GDDR2 - 500 MHz
(32Mx16, Qty 4)

  √  

 AMD RS780MN    √

 AMD UMA graphics subsystem
integrated with shared video
memory (dynamically allocated)

   √

Panels All display assemblies include 2
wireless local area network (WLAN)
antennae

√ √ √ √

 ● 14.1-inch WXGA BrightView √ √ √ √

 ● 14.1-inch WXGA √ √ √ √

 ● 14.1-inch WXGA BrightView
with camera

√ √ √ √

 ● 14.1-inch WXGA with camera √ √ √ √

Memory 2 customer-accessible/upgradable
memory module slots

√ √ √ √

 Supports dual-channel memory √ √ √ √

 Supports up to 4 GB of system RAM √ √ √ √

 PC2-5300, 2048MB and 1024MB,
DDR

PC2-6400, 2048MB and 1024MB,
DDR

√ √ √ √

 PC2-5300 and PC2-6400, 512MB,
DDR

√ √ √  

 Supports the following
configurations:

● 8192-MB total system memory
(4096 × 2, dual-channel)

● 4096-MB total system memory
(4096 x 1, dual-channel)

 √ √ √

 ● 4096-MB total system memory
(2048 × 2, dual-channel)

● 3072-MB total system memory
(2048 + 1024, dual-channel)

√ √ √ √
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Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

● 2048-MB total system memory
(2048 x 1, dual-channel)

● 2048-MB total system memory
(1024 x 2, dual-channel)

● 1024-MB total system memory
(1024 x 1, dual-channel)

 PC2-5300, 667-MHz and PC2-6400,
800-MHz, DDR2

√ √ √ √

 Supports the following
configurations only in Brazil:

● 3072-MB total system memory
(2048 + 1024, dual-channel)

● 2048-MB total system memory
(2048 × 1)

● 2048-MB total system memory
(1024 × 2, dual-channel)

● 1024-MB total system memory
(1024 × 1)

√ √ √ √

Hard drives Supports 9.5-mm (2.5-inch) hard
drives

√ √ √ √

 Customer-accessible √ √ √ √

 Serial ATA √ √ √ √

 Supports the following drives:

● 320-GB, 5400-rpm

● 250-GB, 5400-rpm

● 160-GB, 7200-rpm

● 160-GB, 5400-rpm

● 120-GB, 5400-rpm

√ √ √ √

 ● 120-GB, 7200-rpm   √  

 HP 3D DriveGuard √ √ √ √

Optical
drives

Fixed (removal of 1 screw required) √ √ √ √

 Customer-accessible √ √ √ √

 Serial ATA √ √ √ √

 12.7-mm tray load √ √ √ √
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Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

 Supports the following drives:

● DVD±RW and CD-RW Super
Multi Double-Layer Combo
Drive with LightScribe

● DVD/CD-RW Combo Drive

● DVD-ROM Drive

√ √ √ √

 ● Blu-ray Disc ROM with
SuperMulti DVD±R/RW
Double-Layer Combo Drive

  √  

Diskette
drive

Supports external USB diskette
drive only

√ √ √ √

 Supports boot from external USB
diskette drive

√ √ √ √

Audio HD audio - ADI1984 √ √ √ √

Modem 56K 1.5-inch data/fax modem with
digital line guard

√ √ √ √

Ethernet 10/100 Ethernet network interface
card (NIC)

√ √  √

 Low-cost 10/100/1000 Ethernet
network interface card (NIC)

  √  

 S3/S4/S5 wake on LAN: DC - no √ √ √ √

 S3/S4/S5 wake on LAN: AC - yes √ √ √ √

Wireless Integrated WLAN options by way of wireless module:

 2 WLAN antennae built into display
assembly

√ √ √ √

 Support for no-WLAN option √ √ √ √

 Support for the following WLAN
formats:

● Broadcom 802.11a/b/g/n

● Broadcom 802.11a/b/g

● Broadcom 802.11b/g

√ √ √ √

 ● Intel 802.11a/b/g

● Intel 802.11a/b/g/n

√ √ √  

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option √ √ √ √

 Broadcom Bluetooth 2.0+EDR √ √ √ √
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Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

Media Card
Reader

One ExpressCard/54 slot √ √ √ √

 SD/MMC Card Reader supporting
Memory Stick (MS), Memory Stick
Pro (MSP), MultiMedia Card (MMC),
MultiMedia Card (MMC) Plus,
Secure Digital (SD) Memory Card,
Secure Digital High Capacity
(SDHC) Memory Card, xD-Picture
Card (XD), xD-Picture Card (XD)
Type H, and xD-Picture Card (XD)
Type M

√ √ √ √

Ports Audio-in (stereo microphone) √ √ √ √

 Audio-out (stereo headphone) √ √ √ √

 RJ-11 (modem) √ √ √ √

 RJ-45 (Ethernet, includes link and
activity lights)

√ √ √ √

 USB (4) √ √ √ √

 VGA (Dsub 15-pin) supporting 1600
× 1200 external resolution at 75-GHz
(hot plug/unplug with auto-detect)

√ √ √ √

 3-pin AC power √ √ √ √

Keyboard/
pointing
devices

11.97-inch keyboard with embedded
numeric keypad

√ √ √ √

 TouchPad only, with 2 TouchPad
buttons and vertical scrolling (taps
enabled as default)

√ √ √ √

Power
requirements

90-W AC adapter with localized
cable plug support (2-wire plug with
ground pin, supports 2-pin DC
connector)

  √  

 65-W AC adapter with localized
cable plug support (2-wire plug with
ground pin, supports 2-pin DC
connector)

√ √  √

 6-cell, 47-Wh Li-ion battery √ √ √ √

Security Supports Kensington security sock √ √ √ √

Operating
system

Preinstalled: √ √ √ √

 ● Windows Vista® Home Basic
32

● Windows Vista Business 32
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Category Description Computer
models
equipped with
GL40 system
board

Computer
models
equipped with
GM45 system
board

Computer
models
equipped with
PM45 system
board

Computer
models
equipped with
RS780 system
board

● Windows Vista Business 32
(with Windows® XP Pro
images)

● FreeDOS (limited to Taiwan for
use only with HP Compaq
6531s Notebook PC models)

● Red Flag Linux (in the People's
Republic of China only)

 Restore media: √ √ √ √

 ● Windows Vista 32 Home Basic

● Windows Vista Business 32

● Windows Vista Business 64

● Windows XP Professional

● Red Flag Linux (in the People's
Republic of China only)

● Windows Vista (DRDVD)

● Windows XP Pro (DRDVD)

● Windows Vista (Office Ready -
DVD)

    

 Certified: Microsoft® WHQL √ √ √ √

 Web Support: √ √ √ √

 ● Windows XP Professional

● Windows Vista 32 Home Basic

● Windows Vista Business 32

● Windows Vista Business 64

    

Serviceability End-user replaceable parts:     

 AC adapter √ √ √ √

 Battery (system) √ √ √ √

 Hard drive √ √ √ √

 Memory module √ √ √ √

 Optical drive √ √ √ √

 WLAN module √ √ √ √
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2 External component identification

Top components
Display components

Item Component Function

(1) WLAN antenna locations Send and receive signals from one or more WLAN devices.
These antennae are not visible from the outside of the
computer.

(2) Webcam light (select models only) On: The integrated camera is in use.

(3) Webcam (select models only) Records audio and video and captures still photographs.
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TouchPad

Item Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the
screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Buttons, switch, lights, and speakers

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a wireless
local area network (WLAN) device, the HP Broadband
Wireless Module, and/or a Bluetooth device, is on.

● Off: All wireless devices are off.

(2) Wireless button Turns the wireless feature on or off, but does not establish
a wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

● Off: The computer is off or in Hibernation.

(4) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to initiate
Hibernation.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
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Item Component Function

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(5) Speakers (2) Produce sound.

(6) Internal display switch Turns off the display if the display is closed while the power
is on.

(7) Caps lock light On: Caps lock is on.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) Function keys Execute frequently used system functions when pressed
in combination with the fn key.

(3) num lk key When pressed in combination with the fn key, the num lk
key enables and disables the embedded numeric keypad.

(4) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(5) Windows logo key Displays the Windows Start menu.

(6) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(7) Windows applications key Displays a shortcut menu for items beneath the pointer.
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Front components

Item Component Function

(1) Media Card Reader Supports the following optional digital card formats:

● Memory Stick (MS)

● Memory Stick Pro (MSP)

● MultiMedia Card (MMC)

● MultiMedia Card (MMC) Plus

● Secure Digital (SD) Memory Card

● Secure Digital High Capacity (SDHC) Memory Card

● xD-Picture Card (XD)

● xD-Picture Card (XD) Type H

● xD-Picture Card (XD) Type M

(2) Drive light ● Blinking turquoise. The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

(3) Audio-out (headphone) jack Connects optional powered stereo speakers, headphones,
ear buds, a headset, or television audio.

(4) Internal microphone Records sound.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

Right-side components

Item Component Function

(1) USB ports (2) Connect optional USB devices.
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Item Component Function

(2) Optical drive Reads optical discs and, on select models, also writes to
optical discs.

(3) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left-side components

Item Component Function

(1) RJ-11 (modem) jack Connects a modem cable.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) External monitor port Connects an external VGA monitor or projector.

(4) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(5) Power connector Connects an AC adapter.

(6) RJ-45 (network) jack Connects a network cable.

(7) USB ports (2) Connect optional USB devices.

(8) ExpressCard slot Supports optional ExpressCards.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) Memory module compartment Contains a memory module.

(5) Hard drive bay Holds the hard drive.

(6) WLAN module compartment (select models only) Contains a WLAN module slot.

CAUTION: To prevent an unresponsive system, use only
a wireless module authorized for use in the computer by
the governmental agency that regulates wireless devices
in your country or region. If you install the module and then
receive a warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.
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3 Illustrated parts catalog

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for
the computer.

(5) Warranty period: Describes the duration of the warranty period for this computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components

Item Description Spare part number

(1) Display assembly (include 2 WLAN antenna transceivers and cables)

 For use only with HP Compaq 6535s Notebook PC models  

 14.1-inch, WXGA BrightView display assembly with camera 493155-001

 14.1-inch, WXGA BrightView display assembly 493154-001
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Item Description Spare part number

 14.1-inch, WXGA display assembly with camera 493152-001

 14.1-inch, WXGA display assembly 493151-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models  

 14.1-inch, WXGA BrightView display assembly with camera 491643-001

 14.1-inch, WXGA display assembly with camera 491642-001

 14.1-inch, WXGA BrightView display assembly 491641-001

 14.1-inch, WXGA display assembly 491640-001

 Display internal components: not illustrated

 Display bezel  

 For use only with HP Compaq 6535s Notebook PC models equipped with a webcam 497617-001

 For use only with HP Compaq 6535s Notebook PC models not equipped with a webcam 497619-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models equipped with a webcam 491636-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models not equipped with a
webcam

491635-001

 Display Cable Kit: not illustrated  

 For use only with HP Compaq 6535s Notebook PC models (includes wireless antenna and
webcam cables)

497620-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models (includes wireless
antenna and webcam cables)

491637-001

 Display hinges (left and right hinges)  

 For use only with HP Compaq 6535s Notebook PC models 493170-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491639-001

 Display inverter (includes cable)  

 For use only with HP Compaq 6535s Notebook PC models 497615-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491634-001

(2) Switch cover (includes power button board and cable)  

 For use only with HP Compaq 6535s Notebook PC models 497614-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491663-001

(3) Power button board (included with Switch cover)

(4) Keyboard

 For use in Brazil 491653-201

 For use in Japan 491653-291

 For use in Latin America 491653-161

 For use in South Korea 491653-AD1

 For use in Taiwan 491653-AB1

18 Chapter 3   Illustrated parts catalog



Item Description Spare part number

 For use in Thailand 491653-281

 For use in the United States 491653-001

(5) Speakers  

 For use only with HP Compaq 6535s Notebook PC models 493173-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491656-001

(6) Top cover (includes TouchPad board and cable, and TouchPad button board and cable) 491632-001

(7) Modem module cable (includes RJ-11 connector)  

(8) TouchPad spared with top cover  

(9) Plastics Kit (see Plastics Kit on page 25 for more Plastics Kit spare part information):  

 For use only with HP Compaq 6535s Notebook PC models 493175-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491253-001

(9a) ExpressCard slot bezel

(9b) WLAN module compartment cover

(9c) Hard drive bay cover

(9d) Memory module compartment cover

(10) TouchPad cable spared with top cover  

(11) TouchPad bracket spared with top cover (included in the Top cover kit, which also includes
the TouchPad button board actuators, which are not illustrated)

 

(12) Modem 461749-001

(13) Heat sink (includes replacement thermal material)  

 For use only with HP Compaq 6535s Notebook PC models 493174-001

 For use only with HP Compaq 6531s Notebook PC models 491980-001

 For use only with HP Compaq 6530s Notebook PC models 496679-001

(14) Fan  

 For use only with HP Compaq 6535s Notebook PC models 493177-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 490324-001

(15) Broadcom Bluetooth module

 For use in all countries and regions except Japan and Asia Pacific 398393-002

 For use only in Japan and Asia Pacific 450066-001

(16) USB connector and cable  

 Cable Kit for use only with HP Compaq 6535s Notebook PC models (not illustrated; see Cable
Kit on page 26 for more Cable Kit spare part number information)

497616-001

 Cable Kit for use only with HP Compaq 6530s and 6531s Notebook PC models (not illustrated;
see Cable Kit on page 26 for more Cable Kit spare part number information)

491662-001

(17) System board (includes replacement thermal material and the ExpressCard assembly)
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 ● For use only with computer models equipped with AMD processors 497613-001

 ● For use only with computer models equipped with Intel processors with UMA graphics
subsystem and a GM45 system board

501354-001

 ● For use only with computer models equipped with Intel processors with UMA graphics
subsystem and a GL40 system board

491250-001

 ● For use only with computer models equipped with Intel processors (includes 128-MB
DDR2 discrete graphics system memory)

491977-001

 ● For use only with computer models equipped with Intel processors (includes 256-MB
DDR2 discrete graphics system memory)

491976-001

 Processor (includes replacement thermal material) (not illustrated)

 Intel Core2 Duo processors: (for use only with HP Compaq 6530s and 6531s Notebook PC
models)

 

 ● T5670 1.80-GHz (2-MB L2 cache, 800-MHz FSB) (not available for Japan) 507511-001

 ● T5870 2.0-GHz (2-MB L2 cache, 800-MHz FSB) (not available for Japan) 507512-001

 ● P7370 2.0-GHz (3-MB L2 cache, 1066-MHz FSB) 506455-001

 ● P8400 2.26GHz (3-MB L2 cache, 1066-MHz FSB) 491659-001

 ● P8600 2.40-GHz (3-MB L2 cache, 1066-MHz FSB) 491660-001

 ● T9400 2.53-GHz (6-MB L2 cache, 1066-MHz FSB) 491661-001

 Intel Celeron M processors: (for use only with HP Compaq 6530s and 6531s Notebook PC models)

 ● 575 2.0-GHz (1-MB L2 cache, 667-MHz FSB) 506443-001

 ● 585 2.16-GHz (1-MB L2 cache, 667-MHz FSB) 506444-001

 Intel Celeron Dual-Core processors: (for use only with HP Compaq 6530s and 6531s
Notebook PC models)

 

 ● T1600 1.66GHz (1-MB, 667-MHz FSB) 506453-001

 ● T1700 1.83-GHz (1-MB, 667-MHz FSB) 506454-001

 AMD Turion X2 Ultra Dual-Core mobile processors: (for use only with HP Compaq 6535s Notebook PC models)

 ● ZM–86 2.4GHz (35W 2-MB L2 cache) 493150-001

 ● ZM–84 2.3GHz (35W 2-MB L2 cache) 506283-001

 ● ZM–82 2.2GHz (35W 2-MB L2 cache) 493149-001

 ● ZM–80 2.1GHz (35W 2-MB L2 cache) 493148-001

 AMD Turion X2 Dual-Core mobile processors: (for use only with HP Compaq 6535s Notebook PC models)

 ● RM–72 2.1GHz (35W 1-MB L2 cache) 506282-001

 ● RM–70 2.0GHz (35W 1-MB L2 cache) 493147-001

 AMD Athlon X2 Dual-Core processors: (for use only with HP Compaq 6535s Notebook PC models)

 ● QL–62 2.0GHz (35W 1-MB L2 cache) 506281-001

 ● QL–60 1.9GHz (35W 1-MB L2 cache) 493146-001

 AMD Sempron processor: (for use only with HP Compaq 6535s Notebook PC models)
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 ● SI–40 2.0GHz (25W 512-KB L2 cache) 493145-001

(18) RTC battery 449137-001

(19) Modem module (includes a modem module cable)

 For use only with HP Compaq 6535s Notebook PC models

 For use in all countries and regions except Australia and New Zealand 491575-001

 For use only in Australia and New Zealand 491575-011

 For use only with HP Compaq 6530s and 6531s Notebook PC models

 For use in all countries and regions except Australia and New Zealand 461749-001

 For use only in Australia and New Zealand 461749-011

(20) Base enclosure (includes rubber feet)  

 For use only with HP Compaq 6535s Notebook PC models 493172-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491631-001

 Rubber Kit (not illustrated, contains 6 computer feet and 8 display bezel screw covers)  

 For use only with HP Compaq 6535s Notebook PC models 497622-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491654-001

(21) 6-cell, 47-Wh Li-ion battery  

 For use only with HP Compaq 6535s Notebook PC models 456864-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491657-001

(22) WLAN module

 Broadcom 802.11a/b/g/n WLAN modules:

 ● Broadcom 4321 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S.
Virgin Islands, and the United States

453730-001

 ● Broadcom 4321 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya,
Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,

453730-002
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Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

 Broadcom 4321 802.11a/b/g/n WLAN module for use only in Japan 453730-291

 ● Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S.
Virgin Islands, and the United States

487330-001

 ● Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya,
Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

 Broadcom 802.11b/g WLAN modules:

 ● Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and
Tobago, the U.S. Virgin Islands, and the United States

459263-001

 ● Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya,
Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,

459263-002
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Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

 Intel 802.11a/b/g WLAN module:

 ● Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions 482957-001

 Intel 802.11a/b/g/n WLAN module:

 ● Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions 480985-001

 Broadcom 802.11a/b/g WLAN modules:  

 ● Broadcom 4311AG 802.11a/b/g WLAN module for use in Canada, the Cayman Islands,
Guam, Puerto Rico, the U.S. Virgin Islands, and the United States

441075-001

 ● Broadcom 4311AG 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belgium, Belize, Benin,
Bermuda, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands,
the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory
Coast, Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and
the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

 ● Broadcom 4311AG 802.11a/b/g WLAN module for use in Japan 441075-291

(23) Hard drive (includes hard drive bracket)

 For use only with HP Compaq 6535s Notebook PC models

 320-GB, 5400-rpm 500324-001

 250-GB, 5400-rpm 493165-001

 160-GB, 5400-rpm 493164-001

 120-GB, 5400-rpm 493163-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models

 250-GB, 5400-rpm 491647-001

 160-GB, 7200-rpm 506456-001
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 160-GB, 5400-rpm 491646-001

 120-GB, 7200-rpm 491645-001

 120-GB, 5400-rpm 491644-001

(24) Memory modules (PC2-5300, 667-MHz, DDR2)

 For use only with HP Compaq 6535s Notebook PC models  

 1-GB 493158-001

 2-GB 493159-001

 Memory modules (PC2-6400, 800-MHz, DDR2)

 For use only with HP Compaq 6535s Notebook PC models  

 1-GB 493161-001

 2-GB 493162-001

 Memory modules (PC2-5300, 667-MHz, DDR2)

 For use only with HP Compaq 6530s and 6531s Notebook PC models  

 1-GB 491623-001

 2-GB 491625-001

 Memory modules (PC2-6400, 800-MHz, DDR2)

 For use only with HP Compaq 6530s and 6531s Notebook PC models  

 1-GB 491624-001

 2-GB 491626-001

(25) Optical drive (includes bezel and bracket)

 For use only with HP Compaq 6535s Notebook PC models  

 DVD±RW Double-Layer Drive with LightScribe 493168-001

 DVD/CD-RW Combo Drive 493167-001

 DVD-ROM Drive 493166-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models  

 Blu-ray Disc ROM with SuperMulti DVD±R/RW Double-Layer 491652-001

 DVD±RW Double-Layer Drive with LightScribe 491651-001

 DVD±RW and CD-RW Combo Drive, Double-Layer 491650-001

 DVD-ROM Drive 491649-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit:  

 For use only with HP Compaq 6535s Notebook PC models 493175-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491253-001

(1) ExpressCard slot bezel

(2) WLAN module compartment cover (includes one captive screw, secured by a C-clip)

(3) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(4) Hard drive bay cover (includes 2 captive screws, secured by C-clips)
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Cable Kit

Item Description Spare part number

 Cable Kit

 For use only with HP Compaq 6535s Notebook PC models 497616-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models 491662-001

(1) RJ-11 (modem) jack cable

(2) USB cable

(3) Bluetooth cable
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Item Description Spare part number

(1) Optical drives (include bezel and bracket)

 For use only with HP Compaq 6535s Notebook PC models

 DVD±RW Double-Layer Drive with LightScribe 493168-001

 DVD/CD-RW Combo Drive 493167-001

 DVD-ROM Drive 493166-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models

 Blu-ray Disc ROM with SuperMulti DVD±R/RW Double-Layer 491652-001

 DVD±RW Double-Layer Drive with LightScribe 491651-001

 DVD±RW and CD-RW Combo Drive, Double-Layer 491650-001

 DVD-ROM Drive 491649-001

(2) Hard drives (include bracket)

 For use only with HP Compaq 6535s Notebook PC models  

 320-GB, 5400-rpm 500324-001

 250-GB, 5400-rpm 493165-001

 160-GB, 5400-rpm 493164-001

 120-GB, 5400-rpm 490320-001

 For use only with HP Compaq 6530s and 6531s Notebook PC models  

 250-GB, 5400-rpm 491647-001

 160-GB, 7200-rpm 506456-001

 160-GB, 5400-rpm 491646-001
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 120-GB, 7200-rpm 491645-001

 120-GB, 5400 rpm 491644-001
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Miscellaneous parts
Description Spare part number

AC adapters

65-W AC adapter 463958-001

90-W slimline AC adapter (for use only with HP Compaq 6530s and 6531s Notebook PC models in
all countries and regions except India)

463955-001

90-W slimline AC adapter (for use only with HP Compaq 6530s and 6531s Notebook PC models in
India)

463956-001

Logo Kits

For use only with HP Compaq 6535s Notebook PC models 493178-001

For use only with HP Compaq 6530s and 6531s Notebook PC models 491658-001

Display hardware kit for use only with HP Compaq 6535s Notebook PC models (includes screws,
rubber bumper, display shield, and tape)

500323-001

Nylon carrying case 325814-001

USB 1.1 diskette drive 359118-001

Power cords:

For use in the United States 490371-001

For use in Australia and New Zealand 490371-011

For use in Europe, the Middle East, and Africa 490371-021

For use in the United Kingdom 490371-031

For use in Italy 490371-061

For use in Denmark 490371-081

For use in Switzerland 490371-111

For use in Brazil 490371-201

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in Taiwan 490371-AB1

For use in South Korea 490371-AD1

For use in South Africa 490371-AR1

For use in Iceland 490371-BB1

For use in Argentina 490371-D01

For use in India 490371-D61

Screw Kit  

For use only with HP Compaq 6535s Notebook PC models 493176-001

For use only with HP Compaq 6530s and 6531s Notebook PC models 491655-001

Screw kits include:  
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● Phillips PM2.0×3.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.5×6.0 captive screw

● Phillips PM2.5×5.0 screw

● Phillips PM2.5×4.0 screw

● Phillips PM2.5×9.0 screw

● Phillips PM2.5×10.0 captive screw

● Phillips PM3.0×4.0 screw

● Phillips PM2.0×2.0 broadhead screw (5-mm)

● Phillips PM2.0×2.0 broadhead screw (6-mm)

● Torx T8M2.0×2.0 broadhead (9-mm)

● Slotted Torx ST8M2.5×7.0 screw

● Torx T8M2.5×6.0 screw

● Torx T8M2.5×4.0 screw

30 Chapter 3   Illustrated parts catalog



Sequential part number listing
Spare part
number

Description

325814-001 Nylon carrying case

359118-001 USB 1.1 diskette drive

398393-002 Broadcom Bluetooth module for use in all countries and regions except Japan and Asia Pacific

441075-001 Broadcom 4311AG 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States

441075-002 Broadcom 4311AG 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia and Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman
Islands, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Guadeloupe, Guam, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica,
Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-291 Broadcom 4311AG 802.11a/b/g WLAN module for use in Japan

449137-001 RTC battery

450066-001 Broadcom Bluetooth module for use only in Japan and Asia Pacific

453730-001 Broadcom 4321 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

453730-002 Broadcom 4321 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe
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453730-291 Broadcom 4321 802.11a/b/g/n WLAN module for use only in Japan

456864-001 6-cell, 47-Wh Li-ion battery (for use only with HP Compaq 6535s Notebook PC models)

459263-001 Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada,
the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United
States

459263-002 Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

461749-001 Modem module for use only with HP Compaq 6530s and 6531s Notebook PC models in all countries and
regions except Australia and New Zealand

461749-011 Modem module for use only with HP Compaq 6530s and 6531s Notebook PC models in Australia and New
Zealand

463955-001 90-W slimline AC adapter (for use only with HP Compaq 6530s and 6531s Notebook PC models in all countries
and regions except India)

463956-001 90-W slimline AC adapter (for use only with HP Compaq 6530s and 6531s Notebook PC models in India)

463958-001 65-W AC adapter

480985-001 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions

482957-001 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions

487330-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-002 Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New

32 Chapter 3   Illustrated parts catalog



Spare part
number

Description

Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

490324-001 Fan for use only with HP Compaq 6530s and 6531s Notebook PC models

490371-001 Power cord for use in the United States

490371-011 Power cord for use in Australia and New Zealand

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Iceland

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

491250-001 System board (includes replacement thermal material and the ExpressCard assembly) for use only with
computer models equipped with Intel processors with UMA graphics subsystem and a GL40 system board

491253-001 Plastics Kit for use only with HP Compaq 6530s and 6531s Notebook PC models (see Plastics Kit
on page 25 for more Plastics Kit spare part information)

491575-001 Modem module (for use only with HP Compaq 6535s Notebook PC models in all countries and regions except
Australia and New Zealand)

491575-011 Modem module (for use only with HP Compaq 6535s Notebook PC models in Australia and New Zealand)

491623-001 1-GB memory module (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6530s and 6531s Notebook
PC models

491624-001 1-GB memory module (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6530s and 6531s Notebook
PC models

491625-001 2-GB memory module (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6530s and 6531s Notebook
PC models

491626-001 2-GB memory module (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6530s and 6531s Notebook
PC models
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491630-001 Webcam module (for use only with HP Compaq 6530s and 6531s Notebook PC models)

491631-001 Base enclosure (includes rubber feet) for use only with HP Compaq 6530s and 6531s Notebook PC models

491632-001 Top cover (includes TouchPad board and cable, and TouchPad button board and cable)

491634-001 Display inverter (includes cable) for use only with HP Compaq 6530s and 6531s Notebook PC models

491635-001 Display bezel for use only with HP Compaq 6530s and 6531s Notebook PC models not equipped with a
webcam

491636-001 Display bezel for use only with HP Compaq 6530s and 6531s Notebook PC models equipped with a
webcam

491637-001 Display Cable Kit for use only with HP Compaq 6530s and 6531s Notebook PC models (includes wireless
antenna and webcam cables)

491639-001 Display hinges (includes left and right hinges) for use only with HP Compaq 6530s and 6531s Notebook PC
models

491640-001 14.1-inch, WXGA display assembly for use only with HP Compaq 6530s and 6531s Notebook PC models

491641-001 14.1-inch, WXGA BrightView display assembly for use only with HP Compaq 6530s and 6531s Notebook PC
models

491642-001 14.1-inch, WXGA display assembly with camera for use only with HP Compaq 6530s and 6531s Notebook PC
models

491643-001 14.1-inch, WXGA BrightView display assembly with camera for use only with HP Compaq 6530s and 6531s
Notebook PC models

491644-001 120-GB, 5400-rpm hard drive for use only with HP Compaq 6530s and 6531s Notebook PC models (includes
hard drive bracket)

491645-001 120-GB, 7200-rpm hard drive for use only with HP Compaq 6530s and 6531s Notebook PC models (includes
hard drive bracket)

491646-001 160-GB, 5400-rpm hard drive for use only with HP Compaq 6530s and 6531s Notebook PC models (includes
hard drive bracket)

491647-001 250-GB, 5400-rpm hard drive for use only with HP Compaq 6530s and 6531s Notebook PC models (includes
hard drive bracket)

491649-001 DVD-ROM Drive for use only with HP Compaq 6530s and 6531s Notebook PC models (includes bezel and
bracket)

491650-001 DVD±RW and CD-RW Combo Drive, Double-Layer for use only with HP Compaq 6530s and 6531s Notebook
PC models (includes bezel and bracket)

491651-001 DVD±RW Double-Layer Drive with LightScribe for use only with HP Compaq 6530s and 6531s Notebook PC
models (includes bezel and bracket)

491652-001 Blu-ray Disc ROM with SuperMulti DVD±R/RW Double-Layer for use only with HP Compaq 6530s and 6531s
Notebook PC models (includes bezel and bracket)

491653-001 Keyboard for use in the United States

491653-161 Keyboard for use in Latin America

491653-201 Keyboard for use in Brazil

491653-281 Keyboard for use in Thailand

491653-291 Keyboard for use in Japan
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491653-AB1 Keyboard for use in Taiwan

491653-AD1 Keyboard for use in South Korea

491654-001 Rubber Kit for use only with HP Compaq 6530s and 6531s Notebook PC models (contains 6 computer feet
and 8 display bezel screw covers)

491655-001 Screw Kit for use only with HP Compaq 6530s and 6531s Notebook PC models

491656-001 Speakers for use only with HP Compaq 6530s and 6531s Notebook PC models

491657-001 6-cell, 47-Wh Li-ion battery for use only with HP Compaq 6530s and 6531s Notebook PC models

491658-001 Logo Kit for use only with HP Compaq 6530s and 6531s Notebook PC models

491659-001 Intel Core2 Duo P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB, includes replacement thermal
material)

491660-001 Intel Core2 Duo P8600 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB, includes replacement thermal
material)

491661-001 Intel Core2 Duo T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB), includes replacement thermal
material)

491662-001 Cable Kit for use only with HP Compaq 6530s and 6531s Notebook PC models (includes RJ-11 (modem)
cable, USB cable, and Bluetooth cable)

491663-001 Switch cover (includes power button board and cable) for use only with HP Compaq 6530s and 6531s Notebook
PC models

491976-001 System board (includes replacement thermal material and the ExpressCard assembly) for use only with
computer models equipped with Intel processors (includes 256-MB DDR2 discrete graphics system
memory)

491977-001 System board (includes replacement thermal material and the ExpressCard assembly) for use only with
computer models equipped with Intel processors (includes 128-MB DDR2 discrete graphics system
memory)

491980-001 Heat sink (for use only with HP Compaq 6531s Notebook PC models)

493145-001 AMD Sempron SI–40 2.0GHz processor (25W 512-KB L2 cache)

493146-001 AMD Athlon X2 QL–60 1.9GHz processor (35W 1-MB L2 cache)

493147-001 AMD Turion X2 Dual-Core RM–70 2.0GHz processor (35W 1-MB L2 cache)

493148-001 AMD Turion X2 Ultra Dual-Core ZM–80 2.1GHz processor (35W 2-MB L2 cache)

493149-001 AMD Turion X2 Ultra Dual-Core ZM–82 2.2GHz processor (35W 2-MB L2 cache)

493150-001 AMD Turion X2 Ultra Dual-Core ZM–86 2.4GHz processor (35W 2-MB L2 cache)

493151-001 14.1-inch, WXGA display assembly for use only with HP Compaq 6535s Notebook PC models

493152-001 14.1-inch, WXGA display assembly with camera for use only with HP Compaq 6535s Notebook PC models

493154-001 14.1-inch, WXGA BrightView display assembly for use only with HP Compaq 6535s Notebook PC models

493155-001 14.1-inch, WXGA BrightView display assembly with camera for use only with HP Compaq 6535s Notebook
PC models

493158-001 1-GB memory module (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6535s Notebook PC models

493159-001 2-GB memory module (PC2-5300, 667-MHz, DDR2) for use only with HP Compaq 6535s Notebook PC
models
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493161-001 1-GB memory module (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6535s Notebook PC models

493162-001 2-GB memory module (PC2-6400, 800-MHz, DDR2) for use only with HP Compaq 6535s Notebook PC models

493163-001 120-GB, 5400-rpm hard drive for use only with HP Compaq 6535s Notebook PC models (includes hard drive
bracket)

493164-001 160-GB, 5400-rpm hard drive for use only with HP Compaq 6535s Notebook PC models (includes hard drive
bracket)

493165-001 250-GB, 5400-rpm hard drive for use only with HP Compaq 6535s Notebook PC models (includes hard drive
bracket)

493166-001 DVD-ROM Drive for use only with HP Compaq 6535s Notebook PC models (includes bezel and bracket)

493167-001 DVD/CD-RW Combo Drive for use only with HP Compaq 6535s Notebook PC models (includes bezel and
bracket)

493168-001 DVD±RW Double-Layer Drive with LightScribe for use only with HP Compaq 6535s Notebook PC models
(includes bezel and bracket)

493170-001 Display hinges (includes left and right hinges) for use only with HP Compaq 6535s Notebook PC models

493171-001 Webcam module (for use only with HP Compaq 6535 Notebook PC models)

493172-001 Base enclosure (includes rubber feet) for use only with HP Compaq 6535s Notebook PC models

493173-001 Speakers for use only with HP Compaq 6535s Notebook PC models

493174-001 Heat sink (for use only with HP Compaq 6535s Notebook PC models)

493175-001 Plastics Kit for use only with HP Compaq 6535s Notebook PC models (see Plastics Kit on page 25 for more
Plastics Kit spare part information)

493176-001 Screw Kit for use only with HP Compaq 6535s Notebook PC models

493177-001 Fan for use only with HP Compaq 6535s Notebook PC models

493178-001 Logo Kit for use only with HP Compaq 6535s Notebook PC models

496679-001 Heat sink for use only with HP Compaq 6530s Notebook PC models

497613-001 System board (includes replacement thermal material and the ExpressCard assembly) for use only with
computer models equipped with AMD processors

497614-001 Switch cover (includes power button board and cable) for use only with HP Compaq 6535s Notebook PC
models

497615-001 Display inverter (includes cable) for use only with HP Compaq 6535s Notebook PC models

497616-001 Cable Kit for use only with HP Compaq 6535s Notebook PC models (includes RJ-11 (modem) cable, USB
cable, and Bluetooth cable)

497617-001 Display bezel for use only with HP Compaq 6535s Notebook PC models equipped with a webcam

497619-001 Display bezel for use only with HP Compaq 6535s Notebook PC models not equipped with a webcam

497620-001 Display Cable Kit for use only with HP Compaq 6535s Notebook PC models (includes wireless antenna and
webcam cables)

497622-001 Rubber Kit for use only with HP Compaq 6535s Notebook PC models (contains 7 computer feet and 8 display
bezel screw covers)

500323-001 Display hardware kit for use only with HP Compaq 6535s Notebook PC models (includes screws, rubber
bumper, display shield, and tape)
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500324-001 320-GB, 5400-rpm hard drive for use only with HP Compaq 6535s Notebook PC models (includes hard drive
bracket)

501354-001 System board (includes replacement thermal material and the ExpressCard assembly) for use only with
computer models equipped with Intel processors with UMA graphics subsystem and a GM45 system board

506281-001 AMD Athlon X2 QL–62 2.0GHz processor (35W 2-MB L2 cache) for use only with HP Compaq 6535s Notebook
PC models

506282-001 AMD Turion X2 Dual-Core RM–72 2.1GHz (35W 1-MB L2 cache) for use only with HP Compaq 6535s
Notebook PC models

506283-001 AMD Turion X2 Ultra Dual-Core ZM–84 2.3GHz processor (35W 2-MB L2 cache) for use only with HP Compaq
6535s Notebook PC models

506443-001 Intel Celeron M 575 2.0-GHz processor (1-MB L2 cache, 667-MHz FSB for use only with HP Compaq 6530s
and 6531s Notebook PC models

506444-001 Intel Celeron M 585 2.16-GHz processor (1-MB L2 cache, 667-MHz FSB) for use only with HP Compaq 6530s
and 6531s Notebook PC models

506453-001 Intel Celeron Dual-Core T1600 1.66-GHz processor (1-MB L2 cache, 667-MHz FSB) for use only with HP
Compaq 6530s and 6531s Notebook PC models

506454-001 Intel Celeron Dual-Core T1700 1.83-GHz processor (1-MB L2 cache, 667-MHz FSB) for use only with HP
Compaq 6530s and 6531s Notebook PC models

506455-001 Intel Core2 Duo P7370 2.0-GHz processor (3.0-MB L2 cache, 1066-MHz FSB) for use only with HP Compaq
6530s and 6531s Notebook PC models

506456-001 160-GB, 7200-rpm hard drive for use only with HP Compaq 6530s and 6531s Notebook PC models (includes
hard drive bracket)

507511-001 Intel Core2 Duo T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB) for use only with HP Compaq
6530s and 6531s Notebook PC models, but not available for Japan

507512-001 Intel Core2 Duo T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB) for use only with HP Compaq
6530s and 6531s Notebook PC models
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements 39



Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 75).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This section provides removal and replacement procedures.

There are as many as 89 screws, in 15 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for
the computer.

(5) Warranty period: Describes the duration of the warranty period for this computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part numbers 497622-001 (for use only with HP Compaq 6535s Notebook PC models) and 491654-001
(for use only with HP Compaq 6530s and 6531s Notebook PC models). There are 6 rubber feet that
attach to the base enclosure in the locations illustrated below.
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Battery

Description Spare part number

6-cell, 47-Wh Li-ion battery

For use only with HP Compaq 6535s Notebook PC models 456864-001

For use only with HP Compaq 6530s and 6531s Notebook PC models 491657-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

For use only with HP Compaq 6535s Notebook PC models

320-GB, 5400-rpm hard drive 500324-001

250-GB, 5400–rpm hard drive 493165-001

160-GB, 5400-rpm hard drive 493164-001

120-GB, 5400-rpm hard drive 493163-001

For use only with HP Compaq 6530s and 6531s Notebook PC models

250-GB, 5400-rpm hard drive 491647-001

160-GB, 7200-rpm hard drive 506456-001

160-GB, 5400-rpm hard drive 491646-001

120-GB, 7200-rpm hard drive 491645-001

120-GB, 5400-rpm hard drive 491644-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.5×6.0 captive screws (1) that secure the hard drive bay cover to the
computer.
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3. Lift the right side of the hard drive bay cover (2), swing it to the left, and remove the cover (3). The
hard drive bay cover is included in the Plastics Kit, spare part numbers 493175-001 (for use only
with HP Compaq 6535s Notebook PC models) and 491253-001 (for use only with HP Compaq
6530s and 6531s Notebook PC models).

4. Loosen the Phillips PM2.5×10.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive to the left to disconnect it from
the system board.

6. Remove the hard drive (3) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Broadcom 802.11a/b/g/n WLAN modules:  

● Broadcom 4321 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

453730-001

● Broadcom 4321 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis,
St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

453730-002

● Broadcom 4321 802.11a/b/g/n WLAN module for use only in Japan 453730-291

● Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

487330-001

● Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis,
St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002
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Description Spare part number

Broadcom 802.11/b/g WLAN modules:

● Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

459263-001

● Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin
Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

Intel 802.11a/b/g WLAN module:

● Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions 482957-001

Intel 802.11a/b/g/n WLAN module:

● Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions 480985-001

Broadcom 802.11a/b/g WLAN modules:

● Broadcom 4311AG 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam,
Puerto Rico, the U.S. Virgin Islands, and the United States

441075-001

● Broadcom 4311AG 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Guadeloupe, Guam,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines,
Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,

441075-002
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Description Spare part number

Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

● Broadcom 4311AG 802.11a/b/g WLAN module for use in Japan 441075-291

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the WLAN module compartment
cover to the computer.

3. Lift the right side of the WLAN module compartment cover (2), swing it to the left, and remove the
cover. The WLAN module compartment cover is included in the Plastics Kit, spare part numbers
493175-001 (for use only with HP Compaq 6535s Notebook PC models) and 491253-001 (for use
only with HP Compaq 6530s and 6531s Notebook PC models).

4. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

5. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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6. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion into the WLAN
module slot.

Reverse this procedure to install the WLAN module.

Memory module

Description Spare part number

For use only with HP Compaq 6535s Notebook PC models

2-GB (PC2-6400) 493162-001

1-GB (PC2-6400) 493161-001

2-GB (PC2-5300, 667-MHz, DDR2) 493159-001

1-GB (PC2-5300) 493158-001

For use only with HP Compaq 6530s and 6531s Notebook PC models

1-GB (PC2-5300) 491623-001

1-GB (PC2-6400) 491624-001

2-GB (PC2-5300) 491625-001

2-GB (PC2-6400) 491626-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).
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Remove the memory module:

1. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the memory module compartment
cover to the computer.

2. Lift the front edge of the cover (2), swing it up and back, and remove the cover (3). The memory
module compartment cover is included in the Plastics Kit, spare part numbers 493175-001 (for use
only with HP Compaq 6535s Notebook PC models) and 491253-001 (for use only with HP Compaq
6530s and 6531s Notebook PC models).

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

For use only with HP Compaq 6535s Notebook PC models

DVD±RW Double-Layer Drive with LightScribe 493168-001

DVD/CD-RW Combo Drive 493167-001

DVD-ROM Drive 493166-001

For use only with HP Compaq 6530s and 6531s Notebook PC models

Blu-ray Disc ROM with SuperMulti DVD±R/RW Double-Layer 491652-001

DVD±RW Double-Layer Drive with LightScribe 491651-001

DVD±RW and CD-RW Combo Drive, Double-Layer 491650-001

DVD-ROM Drive 491649-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the slotted Torx ST8M2.5×7.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Switch cover and keyboard

Description Spare part number

Switch covers (includes power button board and cable)  

For use only with HP Compaq 6535s Notebook PC models 497614-001

For use only with HP Compaq 6530s and 6531s Notebook PC models 491663-001

Keyboards for use in the following countries or regions:

Brazil 491653-201 Taiwan 491653-AB1

Japan 491653-291 Thailand 491653-281

Latin America 491653-161 The United States 491653-001

South Korea 491653-AD1   

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the switch cover and keyboard:

1. Remove the following screws:

(1) Two slotted Torx ST8M2.5×7.0 screws

(2) Two Torx T8M2.0×2.0 broadhead (9-mm) screws
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2. Remove the two slotted Torx ST8M2.5×7.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the switch cover (1) straight up until it disengages from the computer, and slide it back (2) until
it rests on the display assembly.
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6. Release the zero insertion force (ZIF) connector to which the LED board cable is attached,
disconnect the LED board cable from the system board (1), and lift the switch cover up to remove
it (2) from the system board.

7. To disengage the four tabs (1) on the back of the keyboard from the switch cover, lift up the rear
edge of the keyboard (2), and slide it back (3).
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8. Release the swinging ZIF connector (1) to which the keyboard cable is attached, and disconnect
the keyboard cable (2) from the system board.

9. Remove the keyboard.

10. Turn the switch cover over.

11. Remove the two Phillips PM2.0×2.0 broadhead screws (1) from the switch cover.

12. Remove the LED power button board (2) from the switch cover.

Reverse this procedure to install the switch cover and keyboard.

60 Chapter 4   Removal and replacement procedures



Speakers

Description Spare part number

For use only with HP Compaq 6535s Notebook PC models 493173-001

For use only with HP Compaq 6530s and 6531s Notebook PC models 491656-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the switch cover (see Switch cover and keyboard on page 57).

6. Remove the keyboard (see Switch cover and keyboard on page 57).

Remove the speakers:

1. Disconnect the speaker cable (1) from the system board and remove the speaker cable from the
clips and routing channel.

NOTE: The two speakers are connected with a single cable.

2. Remove the four Phillips PM2.5×4.0 screws (2) that secure the speakers to the top cover.

3. Remove the speakers (3) from the top cover.

Reverse this procedure to install the speakers.
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Display assembly
NOTE: All display assembly spare part kits include 2 WLAN antenna transceivers and cables.

Description Spare part number

For use only with HP Compaq 6535s Notebook PC models

14.1-inch, WXGA BrightView display assembly with camera 493155-001

14.1-inch, WXGA BrightView display assembly 493154-001

14.1-inch, WXGA display assembly with camera 493152-001

14.1-inch, WXGA display assembly 493151-001

For use only with HP Compaq 6530s and 6531s Notebook PC models

14.1-inch, WXGA BrightView display assembly with camera 491643-001

14.1-inch, WXGA display assembly with camera 491642-001

14.1-inch, WXGA BrightView display assembly 491641-001

14.1-inch, WXGA display assembly 491640-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Switch cover (see Switch cover and keyboard on page 57)

b. Keyboard (see Switch cover and keyboard on page 57)

c. Speakers (see Speakers on page 61)

Remove the display cable:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.

3. Disconnect the display panel cable (1) from the system board.

CAUTION: There is a ground loop off the display panel cable that is secured to the left hinge. Be
sure you do not pull or damage the cable.

4. Disconnect the camera and microphone module cables (2) from the system board, and then
remove the cables from the routing path (3).
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5. Remove the wireless antenna cables (4) from the clips and routing channels built into the top cover.

Remove the display assembly:

1. Remove the following:

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

(1) Four slotted Torx ST8M2.5×7.0 screws that secure the display assembly to the computer.

CAUTION: There is a ground loop off the display panel cable (2) that is secured to the left hinge.
Be sure you do not pull or damage the cable.

(3) Lift the display assembly straight up and remove it.
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2. If it is necessary to replace the display bezel, display inverter, or display hinges, remove the eight
rubber screw covers (1) and the eight Torx T8M2.5×6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part
numbers 497622-001 (for use only with HP Compaq 6535s Notebook PC models) and 491654-001
(for use only with HP Compaq 6530s and 6531s Notebook PC models).

3. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

4. Remove the display bezel (3). The display bezel is available using spare part numbers 497619-001
(for use only with HP Compaq 6535s Notebook PC models without a webcam), 497617-001 (for
use only with HP Compaq 6535s Notebook PC models with a webcam), 491636-001 (for use only
with HP Compaq 6530s and 6531s Notebook PC models with a webcam), and 491635-001 (for
use only with HP Compaq 6530s and 6531s Notebook PC models without a webcam).
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5. If it is necessary to replace the webcam module from the display enclosure, gently pull the webcam
module from the double-sided tape on the display enclosure (1) and disconnect the webcam cable
from the module (2). The webcam module can be ordered by using spare part numbers 491630-001
(for use only with HP Compaq 6530s and 6531s Notebook PC models) and 493171-001 (for use
only with HP Compaq 6535s Notebook PC models).

NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

6. If it is necessary to replace the display inverter, remove the inverter (1) from the display enclosure
as far as the display panel cable and the backlight cable will allow.

7. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

8. Remove the display inverter. The display inverter is available using spare part numbers
497615-001 (for use only with HP Compaq 6535s Notebook PC models) and 491634-001 (for use
only with HP Compaq 6530s and 6531s Notebook PC models).

9. If it is necessary to replace the display hinges, remove the four Torx T8M2.5×5.0 screws (1) that
secure the display panel to the display enclosure.
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10. Remove the display panel (2).

11. Remove the four Phillips PM2.0×3.0 screws (1) that secure each display hinge to the display
panel.

NOTE: When removing or replacing the eight Phillips screws, be sure to remove or replace them
in the same sequence as the numbering found on the display hinges (1–2–3–4).

12. Remove the display hinges (2). The left and right display hinges are available in the Bracket Kit,
spare part numbers 493170-001 (for use only with HP Compaq 6535s Notebook PC models) and
491639-001 (for use only with HP Compaq 6530s and 6531s Notebook PC models).

13. If it is necessary to replace the wireless antenna cables, remove the two Torx T8M2.5×4.0
screws (1) that secure the wireless antenna transceiver to the top cover. The wireless antenna
cables are included in the Display Cable Kit, spare part numbers 497620-001 (for use only with HP
Compaq 6535s Notebook PC models) and 491637-001 (for use only with HP Compaq 6530s and
6531s Notebook PC models).

66 Chapter 4   Removal and replacement procedures



14. Remove the wireless antenna (2).

15. Remove the wireless antenna cables (3) from the clips and routing channels built into the top cover.

16. If it is necessary to replace the webcam cable from the display enclosure, gently pull the webcam
cables (1) from the clips and routing channels (2) built into the top cover. The webcam cable is
included in the Display Cable Kit, spare part numbers 497620-001 (for use only with HP Compaq
6535s Notebook PC models) and 491637-001 (for use only with HP Compaq 6530s and 6531s
Notebook PC models).

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover (includes TouchPad board and cable, and TouchPad button board and cable) 491632-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Switch cover (see Switch cover and keyboard on page 57)

d. Keyboard (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the two rubber screw covers (1) and the seven slotted Torx ST8M2.5×7.0 screws (2) that
secure the top cover to the computer. The rubber screw covers are available in the Rubber Kit,
spare part numbers 497622-001 (for use only with HP Compaq 6535s Notebook PC models) and
491654-001 (for use only with HP Compaq 6530s and 6531s Notebook PC models).

3. Remove the three Phillips PM2.0×2.0 broadhead (5-mm) screws from the optical drive bay (1), and
remove the Torx T8M2.5x4.0 screw from the hard drive bay (2).

4. Turn the computer right-side up.
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5. Remove the two slotted Torx ST8M2.5×7.0 screws from the top cover.

6. Lift the rear edge of the top cover (1) until it disengages from the base enclosure, and then tilt the
top cover (2) back until the TouchPad cable is accessible.

7. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
TouchPad cable from the system board (2).

8. Remove the top cover.
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Reverse this procedure to install the top cover.
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USB connector module
1. Disconnect the USB cable from the system board (1).

2. Lift up the USB connector and remove the cable from the front edge of the base enclosure (2).

3. Remove the long Phillips PM2.5×9.0 screw (3) and the short Torx T8M2.5×4.0 screw (4) from the
system board.

4. Remove the USB connector module (5).

Reverse this procedure to install the USB connector module.
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Bluetooth module

Description Spare part number

Broadcom Bluetooth module for use in all countries and regions except Japan and Asia Pacific 398393-002

Broadcom Bluetooth module for use only in Japan and Asia Pacific 450066-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Switch cover (see Switch cover and keyboard on page 57)

d. Keyboard (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Remove the Bluetooth module cable (2) from the routing path.

3. Remove the Phillips PM2.0×4.0 screw (3) that secures the Bluetooth module to the base enclosure.
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4. Remove the Bluetooth module (4) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

74 Chapter 4   Removal and replacement procedures



RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Keyboard (see Switch cover and keyboard on page 57)

d. Switch cover (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

Remove the RTC battery:

1. Turn the system board upside down, with the audio connectors toward you.

2. Remove the RTC battery from the socket on the system board.
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Reverse this procedure to install the RTC battery.
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Fan

Description Spare part number

Fan 490324-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Switch cover (see Switch cover and keyboard on page 57)

d. Keyboard (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the two Torx T8M2.5×6.0 screws (2) that secure the fan to the base enclosure.
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3. Lift the fan up (3) from the base enclosure.

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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System board
NOTE: All system board spare part kits include the ExpressCard assembly.

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

For use only with computer models equipped with AMD processors 497613-001

For use only with computer models equipped with Intel processors with UMA graphics subsystem
and a GM45 system board

501354-001

For use only with computer models equipped with Intel processors with UMA graphics subsystem
and a GL40 system board

491250-001

For use only with computer models equipped with Intel processors (includes 128-MB DDR2 discrete
graphics system memory)

491977-001

For use only with computer models equipped with Intel processors (includes 256-MB DDR2 discrete
graphics system memory)

491976-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Keyboard (see Switch cover and keyboard on page 57)

d. Switch cover (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

h. USB connector module (see USB connector module on page 72)

i. Bluetooth module (see Bluetooth module on page 73)

j. Fan (see Fan on page 77)

k. RTC battery (see RTC battery on page 75)

Component replacement procedures 79



When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory module (see Memory module on page 53)

● WLAN module (see WLAN module on page 50)

● Processor (see Processor on page 88)

Remove the system board:

1. Remove the RJ-11 connector (1) from the base enclosure clip.

2. Disconnect the Bluetooth module cable (2) and the USB connector module cable (3) from the
system board.

3. Remove the Torx T8M2.5×6.0 screw from the system board.

4. Flex the left side of the base enclosure until the external monitor connector (1) and the heat sink
(2) are clear of the openings in the base enclosure.

5. Lift the rear edge of the system board (3) until it rests at an angle.
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6. Remove the system board (4) from the base enclosure by sliding it back.

Reverse this procedure to install the system board.

Component replacement procedures 81



Modem module

Description Spare part number

For use in all countries and regions except Australia and New Zealand 461749-001

For use only in Australia and New Zealand 461749-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Keyboard (see Switch cover and keyboard on page 57)

d. Switch cover (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

h. System board (see System board on page 79)

Remove the modem module:

1. Turn the system board upside down, with the audio connectors toward you.

2. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system board.

3. Lift the modem module (2) straight up to disconnect it from the system board.
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4. Disconnect the modem module cable (3) .

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Heat sink
NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

For use only with HP Compaq 6535s Notebook PC models 493174-001

For use only with HP Compaq 6531s Notebook PC models 491980-001

For use only with HP Compaq 6530s Notebook PC models 496679-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Keyboard (see Switch cover and keyboard on page 57)

d. Switch cover (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

h. System board (see System board on page 79)

Remove the heat sink:

NOTE: Steps 1 through 3 apply only to HP Compaq 6531s Notebook PC models. See steps 4 through
6 for removing the heat sink on HP Compaq 6530s Notebook PC models. See steps 7 through 9 for
removing the heat sink on HP Compaq 6535s Notebook PC models.

1. Turn the system board upside down, with the audio connectors toward you.

2. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four screws (1) around
the processor.
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3. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1)
and (2), and the system board components (3) and (4) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

NOTE: Steps 4 through 6 apply only to HP Compaq 6530s Notebook PC models. See steps 1
through 3 for removing the heat sink on HP Compaq 6531s Notebook PC models. See steps 7
through 9 for removing the heat sink on HP Compaq 6535s Notebook PC models.

4. Turn the system board upside down, with the audio connectors toward you.

5. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the six screws (1) around the
processor.
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6. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
(1), (2), and (3), and the system board components (4), and (5) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

NOTE: Steps 7 through 9 apply only to HP Compaq 6535s Notebook PC models

7. Turn the system board upside down, with the audio connectors toward you.

8. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the five screws (1) around the
processor.
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9. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1)
and (2), and the system board components (3) and (4) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

AMD processors for use only with HP Compaq 6535s computer models  

Turion Ultra ZM-86 2.40-GHz processor 493150-001

Turion Ultra ZM-84 2.30-GHz processor 506283-001

Turion Ultra ZM-82 2.20-GHz processor 493149-001

Turion Ultra ZM-80 2.10-GHz processor 493148-001

Turion RM-72 2.1GHz (35W 1-MB L2 cache) 506282-001

Turion RM-70 2.00-GHz processor 493147-001

Athlon QL-60 1.90-GHz processor 493146-001

Athlon QL-62 2.0-GHz processor 506281-001

Sempron SI-40 2.00-GHz processor 493145-001

Intel Core2 Duo processors for use only with HP Compaq 6530s and 6531s computer models  

T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB) (not available for Japan) 507511-001

T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB) (not available for Japan) 507512-001

P7370 2.0-GHz processor (3.0-MB L2 cache, 1066-MHz FSB) 506455-001

P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 491659-001

P8600 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 491660-001

T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 491661-001

Intel Celeron M Processors for use only with HP Compaq 6530s and 6531s computer models  

Cel-575 2.0-GHz processor (1-MB, 667-MHz FSB) 506443-001

Cel-585 2.16-GHz processor (1-MB, 667-MHz FSB) 506444-001

Intel Celeron Dual-Core processors for use only with HP Compaq 6530s and 6531s computer
models

 

T1600 1.66-GHz processor (1-MB, 667-MHz FSB) 506453-001

T1700 1.83-GHz processor (1-MB, 667-MHz FSB) 506454-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Hard drive (see Hard drive on page 47)

b. Optical drive (see Optical drive on page 55)

c. Keyboard (see Switch cover and keyboard on page 57)

d. Switch cover (see Switch cover and keyboard on page 57)

e. Speakers (see Speakers on page 61)

f. Display assembly (see Display assembly on page 62)

g. Top cover (see Top cover on page 68)

h. System board (see System board on page 79)

Remove the processor:

NOTE: Steps 1 through 3 apply only to HP Compaq 6530s and 6531s models. See steps 4 and 5 for
instructions on removing the processor on HP Compaq 6535s models.

1. Turn the system board upside down, with the USB connectors toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

3. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

NOTE: Steps 4 and 5 apply only to HP Compaq 6535s models. See steps 1 through 3 for
instructions on removing the processor on HP Compaq 6530s and 6531s models.

4. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.
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5. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the keyboard arrow keys and then press enter, or use
a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

92 Chapter 5   Computer Setup



3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

User Management (requires an administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires an administrator password) Revise password policy criteria.

Allow HP SpareKey Enrollment Enable/disable permission to enroll or reset HP SpareKey.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Fingerprint Reset on Reboot (If Present) Enable/disable the fingerprint reader (select models only;
disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security (requires an administrator
password)

● Change TPM (Trusted Platform Module) Embedded
Security device state at restart. The following options are
available:

◦ Do Nothing (enabled by default)

◦ Available and Disabled

◦ Available and Enabled

◦ Factory Defaults

● Reset Authentication Credential.

● Enable/disable support for the following:

◦ Power-on authentication support (enabled by
default)

◦ Operating system TPM management (enabled by
default)

◦ Reset of TPM from operating system (disabled by
default)

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the selected
drive is destroyed permanently.
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Select To do this

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Setup BIOS Administrator Password Set up a BIOS administrator password.

Always Prompt for HP SpareKey Enrollment Enable/disable a prompt for HP SpareKey enrollment.

Diagnostics menu

Select To do this

System Diagnostics menu ● F1 System Information—Displays the following
information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● F2 Start-up Test—Verifies the system components
needed for starting the computer.

● F3 Run-In Test—Runs a comprehensive check on
system memory.

● F4 Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

● Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN when
not in use (enabled by default).

● Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)

NOTE: Availability of the options above varies by
computer model.
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Select To do this

● Enable/disable secondary battery fast charge (enabled by
default).

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution Technology)
(select models only; disabled by default).

● Enable/disable Dual-Core CPU (select models only;
enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (select
models only; enabled by default).

● Enable/disable embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled by
default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable the ambient light sensor (enabled by default).

● Enable/disable the Notebook Multibay device (enabled by
default).

● Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the Smart Card slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the serial port.
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Select To do this

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

AMT Options (all are disabled by default) NOTE: All AMT options are disabled by default.

● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (CTRL-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on Next Boot.

● Enable/disable Terminal Emulation Mode

● Enable/disable Firmware Progress Event Support.

● Enable/disable Include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 24.64 cm 9.70 in

Width 33.80 cm 13.33 in

Height (front to rear) 3.07 to 3.43 cm 1.21 to 1.35 in

Weight (equipped with optical drive, hard drive, and battery) 2.27 kg 5.00 lbs

Input power

Operating voltage 18.5 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 27.94 cm 11.0 in

Width 20.83 cm 8.2 in

Diagonal 35.56 cm 14.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +20/–40° vertical (typical)
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Hard drive specifications
 320–GB* 250-GB* 160-GB* 120-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 625,122,560 488,376,120 312,560,640 234,420,480

Disc rotational speed 5400 rpm 5400 rpm 5400 rpm 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW Combo Drive, Double-Layer
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2
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DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB  

Data transfer rate   

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)  

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)  

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)  

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)  

Multiword DMA mode 2 16.6 MB/s  
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.

106 Chapter 6   Specifications



System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)

System I/O address specifications 109



System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This chapter provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part numbers
493176-001 (for use only with HP Compaq 6535s Notebook PC models) and 491655-001 (for use only
with HP Compaq 6530s and 6531s Notebook PC models).

Slotted Torx ST8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 18 7.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Seven screws that secure the top cover to the computer
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Where used:

(1) Two screws that secure the switch cover to the computer

(2) Two screws that secure the keyboard to the computer

Where used: 4 screws that secure the display assembly to the computer
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Where used: 2 screws that secure the top cover to the base enclosure
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 10 3.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 8 screws that secure the display hinges to the display assembly
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Phillips PM2.5×6.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 6.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two captive screws that secure the hard drive bay cover to the computer (screws are secured by C-
clips)

(2) One captive screw that secures the WLAN module compartment cover to the computer (screw is
secured by a C-clip)

(3) One captive screw that secures the memory module compartment cover to the computer (screw is
secured by a C-clip)
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Phillips PM2.5×10.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 10.0 mm 2.5 mm 5.0 mm

Where used: One captive screw that secures the hard drive to the computer (screw is secured to the
hard drive bracket)
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Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Silver or Black 4 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the system board

Where used: 2 screws that secure the modem module to the system board
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Torx T8M2.0×2.0 broadhead screw (9-mm)

Color Quantity Length Thread Head diameter

Black 2 2.0 mm 2.0 mm 9.0 mm

Where used: 2 screws that secure the switch cover to the computer
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Phillips PM2.0×2.0 broadhead screw (6-mm)

Color Quantity Length Thread Head diameter

Black 2 2.0 mm 2.0 mm 6.0 mm

Where used: 2 screws that secure the button board to the switch cover
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Torx T8M2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 8 4.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the speakers to the computer

Where used: 2 screws that secure the wireless antenna transceiver to the display enclosure
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Where used: One screw that secures the USB board to the system board

Where used: One screw that secures the top cover to the base enclosure

Torx T8M2.5×6.0 screw

Color Quantity Length Thread Heat width

Black 11 6.0 mm 2.5 mm 5.0 mm
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Where used: 8 screws that secure the display bezel to the display assembly

Where used: One screw that secures the system board to the base enclosure

Where used: 2 screws that secure the fan to the base enclosure
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Phillips PM2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 2 5.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the display panel to the display assembly

Phillips PM2.0×2.0 broadhead screw (5-mm)

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 5.0 mm
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Where used: 3 screws that secure the top cover to the display enclosure

Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver or Black 3 4.0 mm 2.0 mm 4.5 mm

Where used: 2 silver screws that secure the TouchPad bracket and TouchPad button board to the top
cover
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Where used: One black screw that secures the Bluetooth module to the base enclosure
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Phillips PM2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 1 9.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the USB board to the system board
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Phillips PM2.5×10.0 captive screw

Color Quantity Length Thread Head diameter

Silver 16 10.0 mm 2.5 mm 5.0 mm

Where used: 6 captive screws that secure the heat sink to the system board for use only with HP
Compaq 6535s Notebook PC models (screws are secured to the heat sink by C-clips)
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Where used: 6 captive screws that secure the heat sink to the system board for use only with HP
Compaq 6530s Notebook PC models (screws are secured to the heat sink by C-clips)

Where used: 4 captive screws that secure the heat sink to the system board for use only with HP
Compaq 6531s Notebook PC models (screws are secured to the heat sink by C-clips)
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8 Backup and recovery

Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery 
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility, follow these steps:
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NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground

RJ-45 (network) 139



10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

Display 145



15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part

numbers 29,  32
AMT options 99
AMT options, AMT setup prompt

(CTRL-P) 99
AMT options, firmware progress

event supporty 99
AMT options, firmware

verbosity 99
AMT options, terminal emulation

mode 99
AMT options, TYPE-131 in

SMBIOS 99
AMT options, unconfigure AMT on

next boot 99
AMT options, USB key provisioning

support 99
antenna, disconnecting 52
audio, product description 5
audio-in jack

location 12
pin assignments 136

audio-out jack
location 12
pin assignments 136

B
backing up, Windows Vista 130
backing up, Windows XP 134
Backup and Restore

Center 130,  131
base enclosure, spare part

number 21,  34,  36
battery

location 15
removal 46
spare part number 21,  32, 

35,  46
battery bay 15

battery latches 15
battery light 14
BIOS Administrator password 96
Blu-ray Disc ROM with SuperMulti

DVD±R/RW Double-Layer
spare part number 24,  27, 

34,  55
Bluetooth cable

illustrated 26
Bluetooth module

removal 73
spare part numbers 19,  31, 

73
boot options 97
boot order 97
bottom components 15
built-in device

ambient light sensor 98
Bluetooth device radio 98
embedded WLAN 98
fingerprint reader 98
integrated camera 98
LAN/WLAN switching 98
modem 98
Network Interface Controller

(LAN) 98
Wake on LAN 98
wireless button 98
WWAN device radio 98

built-in device options 98
built-in-device

Notebook Multibay 98
button components 10
buttons

power 10
TouchPad 9
wireless 10

C
Cable Kit

contents 26
spare part number 19,  26

cable kit
spare part number 35,  36

cables, service considerations 39
camera

spare part numbers 34,  36
caps lock light 11
carrying case, spare part

number 29,  31
chipset, product description 2
CMOS clearing 43
components

bottom 15
buttons 10
display 8
front 12
keys 11
left-side 14
lights 10
pointing devices 9
right-side 12
speakers 10
top 8
TouchPad 9

computer feet
locations 45
spare part number 45

Computer Setup
accessing 91
Diagnostics menu 96
File menu 94
navigating and selecting 92
restoring factory settings 92
Security menu 95
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System Configuration
menu 97

using 92
computer specifications 100
connectors

power 14
service considerations 39

D
device configurations 97
Diagnostics menu 96
discs

Driver Recovery 135
Operating System 135

Disk Sanitizer 95
diskette drive

precautions 39
product description 5
spare part number 29,  31

display
components 8
illustrated 8

display assembly
removal 62
spare part numbers 17,  62

display bezel
removal 64
spare part number 18,  34, 

64
display cable kit

spare part numbers 34,  36
display component recycling 142
display components 8
display enclosure, spare part

number 18
display hardware kit

spare part number 29,  36
display hinge

removal 66
spare part number 18,  34, 

36,  66
display inverter

removal 65
spare part number 18,  34, 

36,  65
display panel, removal 65
display specifications 101
drive light 12
DriveLock password 95
DriveLock, automatic 95

Driver Recovery disc 135
drives

preventing damage 39
drives, boot order 97
Dual-Core CPU 98
DVD-ROM Drive

spare part number 24,  27, 
34,  36,  55

specifications 105
DVD/CD-RW Combo Drive

precautions 39
removal 55
spare part number 24,  27, 

36,  55
specifications 104

DVD±RW and CD-RW Combo
Drive, Double-Layer

precautions 39
spare part number 24,  27, 

34,  55
specifications 103

DVD±RW DL Drive with LightScribe
spare part number 55

DVD±RW Double-Layer Drive with
LightScribe

spare part number 24,  27
DVD±RW Drive

spare part number 34,  36, 
55

E
electrostatic discharge 40
esc key 11
Ethernet, product description 5
Execution Disable 97
ExpressCard assembly

spare part numbers 19
ExpressCard slot 14
ExpressCard slot bezel,

illustrated 25
external monitor port

location 14
pin assignments 137

F
f11 recovery 132
fan

removal 77
spare part number 19,  33, 

36,  77

feet
locations 45
spare part number 45

File menu 94
fn key 11
front components 12
function keys 11

G
graphics, product description 2
grounding equipment and

methods 42

H
hard disk test 96
hard drive

location 15
precautions 39
product description 4
removal 47
spare part number 34,  37
spare part numbers 23,  27, 

36,  37,  47
specifications 102

hard drive bay 15
hard drive bay cover

illustrated 25
removal 48

hard drive bracket, removal 49
hard drive recovery 132
headphone jack

location 12
pin assignments 136

heat sink
removal 84
spare pare number 35
spare part number 19,  36
spare part numbers 84

hinge
removal 66
spare part number 18,  34, 

36,  66
HP QuickLook 2 98
HP SpareKey enrollment 96

I
I/O address specifications 108
internal display switch 11
interrupt specifications 107
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jacks

audio-in 12
audio-out 12
headphone 12
microphone 12
modem 14
network 14
RJ-11 14
RJ-45 14

K
key components 11
keyboard

product description 6
removal 57
spare part number 34
spare part numbers 18,  57

keypad keys 11
keys

esc 11
fn 11
function 11
keypad 11
num lk 11
Windows applications 11
Windows logo 11

L
LAN Power Save 97
language, changing in Computer

Setup 97
left-side components 14
legacy support, USB 91,  97
light components 10
lights

battery 14
caps lock 11
drive 12
power 10
wireless 10

Logo Kit
spare part number 35

Logo Kit, spare part number 29, 
36

M
mass storage devices, spare part

numbers 27
Media Card Reader 12
memory map specifications 110

memory module
product description 3
removal 53
spare part numbers 24,  35, 

53
memory module compartment 15
memory module compartment

cover
illustrated 25
removal 54

microphone jack
location 12
pin assignments 136

microphone, internal 12
model name 1
modem

spare part number 19
modem jack

location 14
pin assignments 138

modem module
product description 5
removal 82
spare part numbers 21,  32, 

33,  82
monitor port

location 14
pin assignments 137

N
network jack

location 14
pin assignments 139

num lk key 11

O
Operating System disc 135
operating system, product

description 6
optical drive

location 13
precautions 39
product description 4
removal 55
spare part numbers 24,  27, 

55
specifications 103,  104,  105

P
packing guidelines 41
panels, product description 3

parallel port mode 97
password clearing 43
passwords 95
pin assignments

audio-in jack 136
audio-out jack 136
external monitor port 137
headphone jack 136
microphone jack 136
modem jack 138
monitor port 137
network jack 139
RJ-11 138
RJ-45 jack 139
Universal Serial Bus (USB)

port 139
plastic parts 38
Plastics Kit

contents 25
spare part number 19,  25, 

33,  36
pointing device

components 9
illustrated 9

pointing device components
TouchPad 9
TouchPad buttons 9
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pointing devices, product
description 6

port options
1394 port 99
ExpressCard slot 98
flash media reader 99
parallel port 99
serial port 98
Smart Card slot 98
USB port 99

ports
external monitor 14
monitor 14
product description 6
Universal Serial Bus

(USB) 12,  14
power button 10
power button board

spare part number 18
power connector 14
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set requirements 140
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product description 1
removal 88
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product description
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restore the factory settings 94
restoring the hard drive 132
right-side components 12
RJ-11 jack

location 14
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location 14
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removal 75
spare part number 21,  31, 
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IDE (Integrated Drive
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Screw Kit
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spare part number 29,  35, 
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screw listing 111
Secondary Battery Fast
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Automatic DriveLock 95
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System IDs 96
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user management 95
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service considerations 38
service tag 16,  44
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description 7
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setup utility

Diagnostics menu 96
File menu 94
navigating and selecting 92
restoring factory settings 92
Security menu 95
System Configuration

menu 97
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removal 61
spare part number 35,  36
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specifications

computer 100
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DVD-ROM Drive 105
DVD/CD-RW Combo

Drive 104
DVD±RW and CD-RW Combo

Drive, Double-Layer 103
hard drive 102
I/O addresses 108
interrupts 107
memory map 110
optical drive 103,  104,  105
system DMA 106

start-up test 96
static-shielding materials 42
switch cover

removal 57
spare part number 18,  35, 

36
spare part numbers 57

switches
internal display 11

system board
removal 79
spare part number 33,  35, 
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spare part numbers 19,  36, 
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System Configuration menu 97
system date and time 94
System Diagnostics menu 96
system DMA 106
system fan 97
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system memory map 110
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tools required 38
top components 8
top cover

removal 68
spare part number 19,  34, 
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TouchPad 9
TouchPad buttons 9
TouchPad cable

spare part number 19
TouchPad components 9
TouchPad Miscellaneous Kit, spare

part number 19
TouchPad scroll zone 9
transporting guidelines 41
Trusted Platform Module

Embedded Security 95
TXT (Intel Trusted Execution

Technology) 98
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Unified Extensible Firmware

Interface (UEFI) mode 98
unknown password 43
USB cable

illustrated 26
USB connector and cable

spare part number 19
USB connector module

removal 72
USB legacy support 91,  97
USB port
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pin assignments 139

USB port, location 12

V
vents 14,  15
Virtualization Technology 98

W
webcam module

spare part numbers 34,  36
Windows applications key 11

Windows Backup utility 134,  135
Windows logo key 11
Windows recovery 131,  135
Windows Vista operating system

DVD 133
wireless antenna,

disconnecting 52
wireless button 10
wireless light 10
wireless, product description 5
WLAN module
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spare part numbers 21,  31, 

32,  33,  50
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WLAN module compartment cover
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removal 52

workstation guidelines 41
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